Chapter 473

Non-Inferiority Tests for the Ratio of Two Within-Subject Variances in a Parallel Design

Introduction

This procedure calculates power and sample size of non-inferiority tests of within-subject variabilities from a two-group, parallel design with replicates (repeated measurements). This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the within-subject variances.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018).

Suppose $x_{ijk}$ is the response of the $i$th treatment ($i = 1, 2$), $j$th subject ($j = 1, \ldots, N_i$), and $k$th replicate ($k = 1, \ldots, M$). The model analyzed in this procedure is

$$x_{ijk} = \mu_i + S_{ij} + e_{ijk}$$

where $\mu_i$ is the treatment effect, $S_{ij}$ is the random effect of the $j$th subject in the $i$th treatment, and $e_{ijk}$ is the within-subject error term which is normally distributed with mean 0 and variance $V_i = \sigma_{W_i}^2$. Unbiased estimates of these variances are given by

$$\hat{V}_i = \frac{1}{N_i(M - 1)} \sum_{j=1}^{N_i} \sum_{k=1}^{M} (x_{ijk} - \bar{x}_{ij})^2$$

A common test statistic to compare variabilities in the two groups is $T = \hat{V}_1/\hat{V}_2$. Under the usual normality assumptions, $T$ is distributed as an $F$ distribution with degrees of freedom $N_1(M - 1)$ and $N_2(M - 1)$.
**Testing Non-Inferiority**

The following hypotheses are usually used to test for non-inferiority

\[ H_0: \frac{\sigma_{W1}^2}{\sigma_{W2}^2} \geq R0 \text{ versus } H_1: \frac{\sigma_{W1}^2}{\sigma_{W2}^2} < R0, \]

where \( R0 \) is the non-inferiority limit.

The corresponding test statistic is \( T = \left( \frac{\bar{V}_1}{\bar{V}_2} \right) / R0 \).

**Power**

The power of this combination of tests is given by

\[ \text{Power} = P \left( F < \frac{R0}{R1} F_{\alpha,N_1(M-1),N_2(M-1)} \right) \]

where \( F \) is the common F distribution with the indicated degrees of freedom, \( \alpha \) is the significance level, and \( R1 \) is the value of the variance ratio stated by the alternative hypothesis. Lower quantiles of \( F \) are used in the equation.

A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary sample size.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

**Power and Alpha**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of nonequivalent means when in fact the means are equivalent.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of non-equivalence when in fact the null hypothesis is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.

- **Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the ratio of $N_2$ to $N_1$, and then PASS determines the needed $N_1$ and $N_2$, with this ratio, to obtain the desired power. An equivalent representation of the ratio, $R$, is
  \[ N_2 = R \times N_1. \]

- **Enter percentage in Group 1, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed $N_1$ and $N_2$ with this percentage to obtain the desired power.

$N_2$ (Sample Size, Group 2)

This option is displayed if Group Allocation = “Enter $N_2$, solve for $N_1$”

$N_2$ is the number of items or individuals sampled from the Group 2 population.

$N_2$ must be $\geq 2$. You can enter a single value or a series of values.

$R$ (Group Sample Size Ratio)

This option is displayed only if Group Allocation = “Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$.”

$R$ is the ratio of $N_2$ to $N_1$. That is,

\[ R = \frac{N_2}{N_1}. \]

Use this value to fix the ratio of $N_2$ to $N_1$ while solving for $N_1$ and $N_2$. Only sample size combinations with this ratio are considered.

$N_2$ is related to $N_1$ by the formula:

\[ N_2 = \lceil R \times N_1 \rceil, \]

where the value $\lceil Y \rceil$ is the next integer $\geq Y$. 

© NCSS, LLC. All Rights Reserved.
For example, setting $R = 2.0$ results in a Group 2 sample size that is double the sample size in Group 1 (e.g., $N_1 = 10$ and $N_2 = 20$, or $N_1 = 50$ and $N_2 = 100$).

$R$ must be greater than 0. If $R < 1$, then $N_2$ will be less than $N_1$; if $R > 1$, then $N_2$ will be greater than $N_1$. You can enter a single or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for $N_1$ and $N_2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for $N_1$ and $N_2$. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal ($N_1 = N_2$)**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter $N_1$ and $N_2$ individually**

  This choice permits you to enter different values for $N_1$ and $N_2$.

- **Enter $N_1$ and $R$, where $N_2 = R \times N_1$**

  Choose this option to specify a value (or values) for $N_1$, and obtain $N_2$ as a ratio (multiple) of $N_1$.

- **Enter total sample size and percentage in Group 1**

  Choose this option to specify a value (or values) for the total sample size ($N$), obtain $N_1$ as a percentage of $N$, and then $N_2$ as $N - N_1$.

**Sample Size Per Group**

*This option is displayed only if Group Allocation = “Equal ($N_1 = N_2$).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for $N_1$, and also the value for $N_2$.

The Sample Size Per Group must be $\geq 2$. You can enter a single value or a series of values.

**$N_1$ (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter $N_1$ and $N_2$ individually” or “Enter $N_1$ and $R$, where $N_2 = R \times N_1$.”*

$N_1$ is the number of items or individuals sampled from the Group 1 population. $N_1$ must be $\geq 2$. You can enter a single value or a series of values.

**$N_2$ (Sample Size, Group 2)**

*This option is displayed only if Group Allocation = “Enter $N_1$ and $N_2$ individually.”*

$N_2$ is the number of items or individuals sampled from the Group 2 population. $N_2$ must be $\geq 2$. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R \times N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lfloor R \times N1 \rfloor, \]

where the value \( \lfloor Y \rfloor \) is the next integer ≥ Y.

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

M (Measurements Per Subject)
Enter one or more values for M: the number of repeated measurements made on each subject.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is \( M \geq 2 \).

Effect Size

R0 (Non-Inferiority Variance Ratio)
Enter one or more values for the non-inferiority limit for the ratio of the two within-subject variances. When the ratio of the sample variances is less than this value, the treatment group (group 1) is concluded to be “non-inferior” to the reference (group 2) group.

This value must be greater than one. Popular choices are 1.5 and 2.

R1 (Actual Variance Ratio)
Enter one or more values for within-subject variance ratio assumed by the alternative hypothesis. This is the value of \( \frac{\sigma^2 w_1}{\sigma^2 w_2} \) at which the power is calculated. This value should be less than R0.
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to show that it is non-inferior to the standard drug in terms of the within-subject variability. A parallel-group design with replicates will be used to test the non-inferiority.

Company researchers set the non-inferiority limit to 1.5, the significance level to 0.05, the power to 0.90, M to 2 or 3, and the actual variance ratio values between 0.8 and 1.2. They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for the Ratio of Two Within-Subject Variances in a Parallel Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>2 3</td>
</tr>
<tr>
<td>R0 (Non-Inferiority Variance Ratio)</td>
<td>1.5</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.8 0.9 1.1 1.2</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Group 1 Sample Size</th>
<th>Group 2 Sample Size</th>
<th>Measures Per Subject</th>
<th>Non-Inferiority Variance Ratio</th>
<th>Actual Variance Ratio</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9013</td>
<td>88</td>
<td>88</td>
<td>176</td>
<td>2</td>
<td>1.500</td>
<td>0.800</td>
</tr>
<tr>
<td>0.9013</td>
<td>44</td>
<td>44</td>
<td>88</td>
<td>3</td>
<td>1.500</td>
<td>0.800</td>
</tr>
<tr>
<td>0.9017</td>
<td>133</td>
<td>133</td>
<td>266</td>
<td>2</td>
<td>1.500</td>
<td>0.900</td>
</tr>
<tr>
<td>0.9036</td>
<td>67</td>
<td>67</td>
<td>134</td>
<td>3</td>
<td>1.500</td>
<td>0.900</td>
</tr>
<tr>
<td>0.9009</td>
<td>210</td>
<td>210</td>
<td>420</td>
<td>2</td>
<td>1.500</td>
<td>1.000</td>
</tr>
<tr>
<td>0.9009</td>
<td>105</td>
<td>105</td>
<td>210</td>
<td>3</td>
<td>1.500</td>
<td>1.000</td>
</tr>
<tr>
<td>0.9000</td>
<td>357</td>
<td>357</td>
<td>714</td>
<td>2</td>
<td>1.500</td>
<td>1.100</td>
</tr>
<tr>
<td>0.9007</td>
<td>179</td>
<td>179</td>
<td>358</td>
<td>3</td>
<td>1.500</td>
<td>1.100</td>
</tr>
<tr>
<td>0.9001</td>
<td>689</td>
<td>689</td>
<td>1378</td>
<td>2</td>
<td>1.500</td>
<td>1.200</td>
</tr>
<tr>
<td>0.9004</td>
<td>345</td>
<td>345</td>
<td>690</td>
<td>3</td>
<td>1.500</td>
<td>1.200</td>
</tr>
</tbody>
</table>

References

Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.
N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
M is the number of times each subject is measured.
R0 is the non-inferiority limit for the within-subject variance ratio.
R1 is the value of the within-subject variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements
A study is being conducted to assess the non-inferiority of the within-subject variability of two groups by looking at the ratio of their variances. If the sample variance ratio falls below the non-inferiority limit, the treatment (group 1) is concluded to be 'non-inferior' to the reference group. Otherwise, it is not. Group sample sizes of 88 and 88 achieve 90% power to reject the null hypothesis of inferiority at a significance level of 0.050. The non-inferiority limit is 1.500. The variance ratio at which the power is calculated is 0.800. Each subject is measured 2 times.

This report gives the sample sizes for the indicated scenarios.

Plot Section
These plots show the relationship between sample size, R1, and M.
Example 2 – Validation using Chow et al. (2018)

The following example is shown in Chow et al. (2018) page 195.

Find the sample size when the non-inferiority limit is 1.21, the significance level to 0.05, M is 3, the power is 0.8, and the alternative variance ratio value 0.44444444. They obtained N1 = N2 = 13.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for the Ratio of Two Within-Subject Variances in a Parallel Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>3</td>
</tr>
<tr>
<td>R0 (Non-Inferiority Variance Ratio)</td>
<td>1.21</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.44444444444</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Power</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>0.8072</td>
</tr>
</tbody>
</table>

The sample sizes match Chow et al. (2018) exactly.